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Chapter One: Introduction 

Chapter One: Introduction 

This manual describes Copy II ST, a disk backup application for 
the Atari ST computers. Copy II ST can make backup copies of 
your valuable software that has been 'copy-protected', as well as 
copying standard unprotected ST software. 

About This Manual 

This manual assumes that you are familiar with the basic 
concepts of the ST, including such things as windows,menus, 
selecting with the mouse, etc. If you need to know more about 
these things, you will need to refer to your ST owner's manual. 

This introduction describes what Copy II ST does, what it is for, 
and what features it includes. 

Chapter Two explains how to do basic disk copying with 
Copy II ST. You should be able to back up most protected 
programs simply using the information in Chapter Two. 

Chapter Three talks about the other copy capabilities and options 
you can select. For those who have one or more nOK (double
sided) drives, this chapter also explains the differences in 
copying with nOK drives. 

Chapter Four provides helpful notes and ideas for working with 
those disks which are more difficult to copy. 

Why Copy II ST? 

Even though an Atari ST diskette is rather rugged, the 
information that is stored on the diskette is actually quite fragile. 
A disk can be permanently damaged by accidentally spilling 
coffee or soda pop on it, leaving it out in a warm place for too 
long, running over it with a truck, etc . And even if a disk is in 
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physically good condition, some or all of the information stored 
on the disk can be lost forever if you pass the disk too close to a 
magnet or motor. If you confuse one disk with another, it's also 
possible to insert the wrong disk at the wrong time and 
mistakenly select to destroy your valuable information. 

For all of these reasons, it's an excellent idea to keep backups of 
your application and data disks at all times. That way, if 
something ever happens to one of your disks, all is not lost. You 
can simply begin using the backup that has been safely stored 
away. Under the copyright law, you are entitled to make 
backups of the software you own for your own use. You are not 
allowed to give or sell copies of copyrighted software to others. 

Some software companies, to prevent illegal duplication, 'copy
protect' the information on their disks. Though the techniques 
used in copy protection are all quite complicated, the end result 
is that the protected disk cannot be copied using normal copy 
methods . This discourages illegal copies from being made, but it 
also keep customers from being able to make legal, useful 
archival backups. 

Copy II ST is designed for copying these protected disks . It 
basically transfers all of the information from one floppy disk 
onto another, so that the duplicate disk is a 'carbon-copy' of the 
original. If the original is copy-protected, the duplicate will be 
too. 

The Copy II ST application program is provided to help you 
make backups of your copy-protected disks for your own use. It 
may not be used for illegal copying. 

The Copy II ST disk is not copy-protected in any way. You can 
make a backup of this disk using the GEM Desktop, Copy II ST 
itself, or any other standard ST copy program. (Unlike some bit 
copy manufacturers, we believe your right to make archival 
backups extends to our product as much as any other product.) 
We encourage you to make a backup copy and put your original 
Copy II ST disk in a safe place. 
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Features of Copy II ST 

Using Copy II ST can be as simple as opening the Copy II ST 
application, clicking on the Start button, and inserting the 
original and duplicate disks. In most cases this is all you need to 
do to make a working backup of your software. 

Several other options are provided. You can copy an entire disk, 
or select a range of tracks to copy only a portion of the disk. If 
you have a second disk drive, you would normally copy from 
one drive to another, or you can select to use just one drive if 
you like. Copy II ST also makes use of whatever memory is 
available in your computer to speed up copying. 

Copy II ST provides two copy options . The Bit Copy option is 
useful for making backups of protected software because it 
makes very few assumptions about the format of the disk it's 
copying. 

The Sector Copy option will copy some protected disks , but is 
mainly intended for backing up standard ST disks. Sector Copy 
is faster than Bit Copy in duplicating a disk. 

In a few cases, Bit Copy and Sector Copy can be used together 
to make a more reliable copy than either option can alone. All of 
this is explained in better detail in Chapter Three and Chapter 
Four. 

Copy II ST cannot copy onto hard disks. Hard drives store and 
retrieve information in a different way than floppy drives . Disk 
copying from floppies to hard disks simply doesn't work. If you 
want to copy individual application and data files onto a hard 
disk, you can often use the file - copying capabilities of the GEM 
Desktop. If, however, the programs you want to move to hard 
disk are copy-protected, you might want to ask the manufacturer 
of the software if a hard disk version is available. 
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Chapter Two: Using Copy II ST 

To start using Copy II ST, first start up your Atari ST in the 
usual way to bring up the GEM Desktop. (Note: The Atari 
display must be in medium or high resolution mode when using 
Copy II ST. If necessary, use Set Preferences from the Desktop's 
Options menu to select either medium or high resolution graphics 
before continuing.) 

Now insert the Copy II ST disk into the drive, then open the 
corresponding disk icon by either clicking on the icon and 
selecting Open from the File menu, or simply double-clicking 
the icon. A window for the Copy II ST disk will appear. One of 
the icons in the window shows the name "COPYIIST.PRG". 
Open this icon. The disk will whir as the Copy II ST application 
is loaded into the computer. 

Copy II ST will then display a screen similar to the following: 

,,1\ OPtions 
COpy] [ ST~ 1.8 

~ 
Original Drivp : 

~ [ID Bit Copy 

0 Sp[tor Copy With Fo~at 
[ID Drivp A 

0 Sp[tor Copy no Fo~at 
0 Drivp B 

0 Doublp Sidpd Copy 

Dupli[atP Drivp : 0 Drivp A Start Track : mJ [IDA DB 
[ID Drivp B End Tra[k : em OA [IDB 
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The first thing to notice is the menu bar at the top of the screen. 
If you choose the 'Atari' menu, you can see that all of the usual 
ST desk accessories are available. You'll also see one other 
option, called About Copy II ST. This option is simply a 
copyright message for Copy II ST. 

By choosing the Options menu , you' ll find that the only option 
available here is Quit. Select Quit from the Options menu 
whenever you want to quit out of the Copy II ST application and 
return to the GEM Desktop. 

Making a Backup 

Copy II ST works by 'reading' some of the information from the 
original disk it's copying, then 'writing' that information onto 
the duplicate disk. It alternates this reading and writing process 
until the entire disk is copied. How much it reads and writes at 
anyone time depends on how much memory you have in your 
computer. 

Before you back up a disk with Copy II ST, we suggest you first 
make sure that the disk is 'write-protected' (which is not the 
same as 'copy-protected'). To write-protect a disk, slide the 
small tab in the corner toward the edge of the disk, uncovering 
the hole. 

Write-protecting a disk guarantees that the computer cannot 
write or change any information on the disk. Suppose that while 
using Copy II ST, you accidentally inserted the original disk at 
the wrong time or into the wrong drive. Even if this happens, 
the information on your original disk can't be hurt because the 
disk is write-protected . (You can later move the write-protect 
tab back to the unprotected position any time you wish to record 
information on the disk.) 
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Start Copy 

In the top of the Copy II ST window, you'll see two buttons, 
labeled Start and Stop. The Start button starts the copying, and 
the Stop button stops it. (The Stop button is 'dimmed' right now 
because there isn't any copying to stop .) The copying doesn't 
begin until you click on the Start button. You can click all the 
other areas without hurting anything . 

Copy II ST is already set up for you to begin copying most disks. 
When you want to copy a disk, click on the Start button with the 
mouse. What happens next depends on whether you have one or 
two drives. 

Copying {one drive} 

If you have one drive, a message will appear in a Dialog Box in 
the middle of the screen: "Insert the write-protected original disk 
in Drive A." Eject any disk that is currently in drive A. Make 
sure the disk you want to back up is write-protected, insert it 
into drive A, then click on the "OK" button. The drive will whir 
as Copy II ST reads some of the information from the original 
disk. 

Copy II ST will then print a new message: "Insert the duplicate 
disk in drive A." Eject the original disk and insert a blank disk 
or a disk you don't mind erasing into the drive. (This disk 
should not be write-protected, so that Copy II ST can write new 
information onto it.) Click on the "OK" button. The drive will 
whir again as the information is written onto the disk. 

This original-disk/duplicate-disk cycle will continue a few more 
times until the entire disk is copied. Copy II ST will then stop 
and be ready for the next disk copy. 
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Copying (two drives) 

If you have two drives, a message will appear in a Dialog Box in 
the middle of the screen: "Insert the write-protected original disk 
in Drive A and the duplicate disk in drive B." 

Eject any disks that are currently in the drives. Make sure the 
disk you want to back up is write - protected, and insert it into 
drive A. Insert a blank disk or a disk you don't mind erasing 
into drive B. (This disk should not be write-protected, so that 
Copy II ST can write new information onto it.) Now click on the 
"OK" button. 

The two drives will then whir as Copy II ST alternately reads 
information from the original disk and writes it to the duplicate 
disk. When the entire disk is copied, Copy II ST will then stop 
and be ready for the next disk copy. 

Stop Copy 

If you want to stop the copying before it's finished, click and 
hold on the Stop button. Copy II ST may continue for a couple 
of seconds more if it's busy reading or writing, then it will stop. 

When copying is finished, you can either make another copy, or 
Quit out of Copy II ST in order to try the copy you just made. 

Copy Status 

The information stored on a normal ST disk is divided into 80 
circu lar tracks, numbered track 0 to track 79. (A few copy
protected disks use additional tracks, numbered 80 to 83.) 
Information about all the tracks copied so far is kept in the 
Copy Status box. The Copy Status box has positions for all 80 
tracks: 4 rows with 20 tracks per row (then a few more positions 
for the additional tracks). 
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The Copy Status box keeps you informed of what Copy II ST is 
currently doing. As Copy II ST reads a track, the letter "R" 
appears in the corresponding position of the Copy Status box. 
As it writes a track, the letter "W" appears. Then for every track 
which is copied successfully, a dot is left behind in each 
position . If there was an error copying a track, a letter is left 
behind instead. The letter indicates what kind of error occurred. 
An "R" means a Read error, a "W" means a Write error. 

For example, if tracks 0 through 23 have been copied so far and 
there was a read error on track 17, the Copy Status box would 
look like this: 

Copy Status 
81234~678981234~67~j 

I. I. '. I. I. ft , I . 

(Note for 720K drive users: On 720K disks, each of the 80 
tracks is further divided into two sides, which we call side A 
and side B. If you're copying a 720K disk, you'll see TWO dots 
or letters appear for each track, one for each side of the track.) 

If you do get errors during a copy, there are some recommended 
ways of handling them. These are discussed in Chapter Four. 
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Chapter Three: Other Backup Options 

This chapter describes the other options available in Copy II ST 
and what they're used for. (The notes in Chapter Four talk about 
when to use them in backing up a disk.) Additional options 
become available if you have one or two 720K (double-sided) 
drives. These extra options are discussed at the end of this 
chapter. 

Bit Copy and Sector Copy 

As mentioned in the Introduction, there are actually two methods 
available for copying a disk with Copy II ST, called Bit Copy 
and Sector Copy. You can see these options in the upper right 
part of the screen. 

A\ OPtions 
COPY l[ S114 1.8 

~ I SHlr I lID Bit COllY 

D Spctor Copy With Fornat 
Original Drivp : lID Drivp A 

D Spctor Copy no Fornat 

When Copy II ST is first started, the Bit Copy method is already 
selected. You can switch to the Sector Copy method by clicking 
on either Sector Copy with Format or Sector Copy no Format. 
Clicking on Bit Copy will switch back to the Bit Copy method. 
Whenever you click on the Start button, Copy II ST will use the 
method you've selected. 

Sector Copy matches the way the Atari ST usually reads and 
writes to the disk in everyday use. Because it 'assumes' that what 
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it's copying is in a normal ST format (with no funny copy
protection), it can make a special effort to be sure that 
everything on the disk is exactly as it should be. This makes for 
very reliable copies. It cannot back up disks that differ too far 
from the normal ST disk format. Sector Copy can also copy a 
disk faster than Bit Copy. 

Since Sector Copy can write only onto formatted disks, you can 
select Sector Copy with Format or Sector Copy no Format. If 
you're sure that the duplicate disk you want to copy onto is 
already formatted, selecting "no Format" will speed up the copy 
process a little. Otherwise you should select Sector Copy with 
Format, so that Copy II ST will format the duplicate disk track
by-track as it copies. 

Bit Copy is designed for copying nearly all copy-protected disks. 
Because of the widely varying protection schemes possible, Bit 
Copy makes very few assumptions about the information it's 
copying. It simply 1) reads the information from the original 
disk, 2) makes enough sense of it so that it can write it 
correctly, then 3) writes it to the duplicate disk. Bit Copy can 
copy many more disks than Sector Copy. 

Bit Copy formats the duplicate disk as it copies, so the disk does 
not have to be formatted ahead of time. 

Original Drive and Duplicate Drive 

Below the Start and Stop buttons are options for "Original Drive:" 
and "Duplicate Drive:". The original drive is the drive in which 
you will put the original disk you're making a copy of. The 
duplicate drive is where your copy will be made. 

For both Original Drive and Duplicate Drive, you'll see two 
choices, labeled A and B. If you have two drives, initially A will 
be selected for Original Drive, and B will be selected for 
Duplicate Drive. This means Copy II ST will copy from drive A 

10 



Chapter Three: Other Backup Options 

to drive B. If you want to change this, just click on the options 
you want for original and duplicate drives. 

If you have one drive, then A will be selected for both Original 
and Duplicate Drives. Since only drive A is available, Copy II ST 
will use it for both original and duplicate disks. Clicking on the 
drive B option has no effect. 

Start Track and End Track 

The next two options are Start Track and End Track. As 
mentioned earlier, the information stored on Atari ST disks is 
recorded in 80 (or up to 84) circular 'tracks', numbered 0 
through 79 (or 0 through 83). With a Start Track of 0 and an 
End Track of 79, Copy II ST will copy the usual 80 tracks of the 
disk. You can also copy a range of tracks if you want, though 
you usually won't need to do this. (There are a few exceptions, 
which are explained in Chapter Four.) 

To change either Start Track or End Track values, use the mouse 
to point the arrow at one of the digits you want to change, then 
press the left mouse button. Every mouse click on a digit will 
increase the digit by 1. (After it's reached the limit, the digit 
will reset to 0.) 

Copy II ST will not let you set the track number greater than 83. 
If you want to set a track number from 80 to 83, first set the 1 's 
digit between 0 and 3, then set the 10's digit to an 8. 

If the Start Track is greater than the End Track, no copying will 
take place until the Start Track is adjusted to less than or equal 
to the End Track. If you want to copy a single track, simply set 
both Start Track and End Track to that track number. 

11 
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720K Drive Options 

If you have either one or two nOK (double-sided) drives, Copy 
II ST can make backups of nOK disks. 

A distinction must be made here between nOK drives and 720K 
disks. A nOK drive is capable of reading, writing, and 
formatting both nOK disks and 360K disks. A 360K drive can 
work only with 360K disks. (Currently, most copy-protected 
application programs sold are on 360K disks, so that they can 
work in both 360K and nOK drives.) Since Copy II ST makes a 
'carbon-copy' of a disk (including its size), the duplicate will 
always be the same size as the original. 

Copy II ST includes a checkbox for you to select whether or not 
to make a double-sided copy. If you have 360K drives, you 
should not select this option. If you have only one nOK drive, 
to make a double-sided copy, you'll need to use the one nOK 
drive for both Original and Duplicate. 

You should always check the Double-Sided Copy box to match 
the size of the original disk you're copying. If you do a Double
Sided Copy of a 360K (single-sided) disk, Copy II ST will take 
twice as long, copying twice as much as it needs to. Similarly, 
you should never need to do a 360K copy of a nOK disk. The 
resulting duplicate disk would be missing much of the 
information it needs to work correctly. 

If you need to recopy just a portion of a nOK disk, notice that 
the Start Track and End Track options include selections labeled 
A and B. As mentioned earlier, on nOK disks, each of the 80 
circular tracks is further divided into two sides, which we call 
side A and side B. When doing a nOK copy, Copy II ST must 
back up both sides of each track. Copying a nOK disk involves 
copying with a Start Track of O-A and an End Track of 79-B. 
To copy just a portion of a nOK disk, you can select which 
track and side to use for Start Track and End Track. 
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Note: A common misconception about 720K disks is the idea that 
you can disk - copy two 360K disks onto one 720K disk, one onto 
the top and one onto the bottom of the disk. The Atari ST drives 
don't work this way. For each physical disk, only one disk icon 
can appear on the GEM Desktop. The Atari ST can't recognize 
"two- disks-in - one". It's better to think of double-sided disks 
simply as disks that can hold twice as much information, and not 
be concerned with when the top and when the bottom of the 
disk is being accessed. 

13 
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Chapter Four: Notes in Backing Up Disks 

When backing up a protected disk, the copy may run normally 
even if an error occurred while copying. Conversely, it's possible 
for a backup to fail even if there were no apparent errors during 
copying. This is because of the complicated protection methods 
used on some disks. The best test in every case is to simply try 
running the program to see if it works. 

Possible Errors 

When the Sector Copy method is selected, an "R" (Read) error on 
every track means the original disk is probably blank. If you get 
this error on only one or two tracks, then a portion of the disk 
may be copy-protected, or there may simply be a problem on 
that part of the disk. A "W" (Write) error means the duplicate 
disk probably isn't formatted correctly on every track. Try Sector 
Copy with Format. If that still doesn't work, then there is 
possibly some kind of problem with the duplicate disk. You 
should try a different disk. 

When the Bit Copy method is selected, a Read error means that 
Copy II ST is having difficulty making sense of this track. 
Copy II ST will do its best to correctly write the track onto the 
duplicate disk anyway. 

Using Sector Copy with Bit Copy 

Most ST application programs on the market today use a strange 
copy-protection format on only a few tracks of the disk. The 
rest of the disk is usually in a standard Atari ST format. Then 
when you start up the application, it begins by checking those 
strange tracks to make certain they haven't been changed at all. 

What this means is that you can often use the Sector Copy 
method to make a fast, reliable copy of most of the tracks on a 
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disk. If you copy a protected disk with Sector Copy and get 
Read errors on only one or two tracks, first try the backup. If 
that doesn't work, then go back and use Bit Copy to recopy just 
the bad tracks back onto the same duplicate disk. The backup 
may now work, and the copying was faster since Sector Copy 
was used for most of the disk. 

Extra Tracks 

Standard Atari ST formatted disks store information on tracks 0 
to 79. A few copy-protected programs also place information on 
tracks 80 to 83 . The idea behind this copy-protection is that 
since standard copy programs will not copy these extra tracks, 
the copy will fail. 

But these extra tracks are not included on standard ST disks for 
a good reason: Because some disk drives cannot access the extra 
tracks, this type of protection scheme may even prevent the 
original disk from working in some machines. 

Since this protection scheme is currently in use by some software 
manufacturers anyway, Copy II ST provides a way to back these 
disks up. If you need to copy a disk with this protection scheme, 
first be sure you have drives that can access the extra tracks. (If 
the original disk that uses this protection runs from both of your 
drives, then the drives can access these tracks.) Change the End 
Track value from 79 to 83, then do the copy. 

A Checklist 

A few commercial software products use particularly nasty 
protection schemes which a straightforward Bit Copy may not 
duplicate correctly. Here is a checklist of things to try in 
backing up these disks. 

First try copying the disk using Bit Copy. 
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If that copy doesn't work, try Sector Copying the disk. Then if 
there are errors on any tracks, recopy just those tracks onto the 
same duplicate disk using Bit Copy. (The Start Track and End 
Track options let you select a single track or a range of tracks to 
copy.) 

Try also copying tracks 80 to 83. 

If these suggestions don't work for you, you might want to drop 
us a note to let us know about it, so we'll know which products 
are in demand. Describe what you tried and what happened 
when you tested the backup. Also, if one method for backing up 
a disk worked particularly well for you, you might want to let us 
know about that too. Include 1) the name and version number of 
the program you were copying, 2) the publisher's name, and 
3) what copy method you used. Address your letter to: 

Central Point Software, Inc. 
9700 SW Capitol Hwy., #100 
Portland, OR 97219 

Have fun and good luck! 
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Sample screen: 
the COPY II STTM menu 

• Protect your software investment! 

Hardware requirements: 
Atari 520/ 1040 ST, 
one or two single-
or double-sided drives. 

Make backup copies of most protected and unprotected computer 
programs. Central Point's state-of-the-art technology handles even the 
most sophisticated protection schemes! You'll have a backup handy should 
misfortune befall your original disk. 

• Fast sector copy for reliable backup of data disks. 

• Supports one or two single- or double-sided drives. 

• Uses all available memory. 

• Everything you wanted to know, but were(n't) afraid to ask ... 
Whether you're a novice or an experienced computer buff, you'll find your 
COPY II STTM manual easy to read, easy to follow and, most of all, easy to 
understand. 

Important license Provision : Under the Federal Copyright Ad an owner of a copy of a computer program 
is entitl ed to make a new copy for archival purposes only. Some software is licensed, not so ld. Subject to 
State Law regarding the enforceabili ty of that license, your right to make archiva l backups may be limited, 
or not exist. We suggest you check whether your state law applies to you in th is regard. This product is 
supplied for lawful purposes only and you are not permitted to use it in vio lation of Federal Copyright Law 
or State Software license Enforcement Laws_ By breaking this seal and/ or using this product, you agree 
to be bound by the terms of this notice. If you are not willing to comply with this notice, do not break the 
sea l. Please immediately retu rn this product to us and we wi ll promptly refund your purchase price. 

Central Point Software, Inc. 
publisher of the bestsell ing 
COPY II PLUS for Apple II series, 
COPY II MAC for Apple Macintosh, 
COPY II 64/ 128 for Commodore 64 & 128 . 
COPY II PC for IBM and compatibles. 
COpy II ST for Atari 520/ 1040 ST 

Central Point Software, Inc. 
9700 SW Capitol Highway 

Su ite 100 
Portland, Oregon 972 19 

Telephone: 
5031244·5782 

Apple II , App le Macintosh, Commodore 64 & 128 , IBM PC, and Atari 520 / 1040 ST are trademarks 01 
Apple, Commodore, IBM, and Atari respec tive ly. 

• 

• 
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